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1 Zielsetzung

Ziel  des  im Folgenden  beschriebenen Druckservice  (Web  Map Print  Service  - 
WMPS)  ist  es,  den  zentralen  Ausdruck  großformatiger  Karten  mit  einem 
definiertem  Raumausschnitt  oder  Maßstab  zu  ermöglichen.  Grundlage  der 
Kartenerstellung sind OGC Web Map Services, die mittels GetMap-Anfragen die 
auszudruckenden Karten liefern sowie der direkte Zugriff auf Vektordaten. Der 
Druck erfolgt auf einem zentralen Drucker (z.B. DIN A0-Plotter), der direkt vom 
Druckservice angesprochen wird oder in eine Datei (*.pdf, *.html, *.rft).

Der Druckservice wird durch einen Administrator verwaltet, der die Verbindung 
zu  den  Datenquellen  und  zum  verwendeten  Drucker  herstellt  sowie  die  den 
Nutzern zur Verfügung stehenden Druckformatvorlagen (Templates) bereitstellt. 
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Abbildung 1: Anwendungsfalldiagramm zur Nutzung und Administration des 
Druckservice
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2 Funktion

Die Funktion des Druckservice umfasst im Wesentlichen das Entgegennehmen 
eines Druckauftrags über das im folgenden Abschnitt spezifizierte Anfrageformat 
sowie  die  asynchrone  Abarbeitung  von  Druckaufträgen.  Die  Asynchronität  ist 
notwendig, da es möglich ist, 

a) dass mehrere Druckaufträge zeitgleich eingehen, jedoch nur ein Drucker zur 
Ausgabe zur Verfügung steht;

b) die Abarbeitung eines Druckauftrags u.U. einen längeren Zeitraum in Anspruch 
nimmt und während dieser Zeit die Netzverbindung zum Client nicht aufrecht 
erhalten werden kann/soll.

Nach Entgegennehmen eines Druckauftrags wird dieser daher zunächst in einem 
Auftragsstapel  (Datenbank) abgelegt.  Sobald der Druckservice über  genügend 
Ressourcen verfügt – es befindet sich kein Druckauftrag in der Bearbeitung – wird 
der  jeweils  älteste  Druckauftrag  aus  dem Stapel  geholt  und  zur  Bearbeitung 
weitergereicht (Abbildung 2). 

Der Druckservice entscheidet anhand seiner Konfiguration, die im Wesentlichen 
der eines deegree WMS entspricht, welchen Teil der Anfrage er an erreichbare 
WMSe weiterreicht  und welchen er  selbst  bearbeitet.  Ersteres  bedeutet,  dass 
nach Berechnung der entsprechenden BoundingBox und Bildgrösse, das Abrufen 
der Karte in mehrere Kacheln aufgeteilt wird, um die Kapazitäten der angefragten 
WMS  nicht  zu  überschreiten.  Um  einen  Teil  der  Kartenerstellung  selbst 
vornehmen zu können, benötigt der Druckservice Zugriff auf die entsprechenden 
Vektordatenquellen  (z.B.  Datenbanken).  Die  Zugriffe  auf  diese  Daten  müssen 
nicht  gekachelt  werden,  da  von einer  vertretbaren Datengrösse  ausgegangen 
werden kann. Ferner liegt es in der Verantwortung des Druckservice bzw. des 
Adminstrators  festzulegen,  wieviel  Zeit  der  Service  zur  Abfrage  der  Daten  in 
Anspruch nehmen kann.

Im  ersten  Schritt  zeichnet  der  Druckservice  die  vom  angebundenen  WMS 
abgefragte Hintergrundebene, anschliessend werden die vom Druckservice direkt 
verarbeiteten  Vektordaten  darüber  gezeichnet.  Nach  Abschluss  des 
Druckvorgangs wird der Nutzer, der den Druckauftrag gesendet hat, mittels E-
Mail  über den Abschluss des Druckauftrags informiert.  Je  nach angefordertem 
Format enhält diese Mail einen Hinweis darauf, das die ausgedruckte Karte beim 
Administrator  abgeholt  werden  kann,  oder  einen  Hyperlink  zum  erzeugten 
Dokument.1

1In der ersten Version des Druckservice wird lediglich die Erzeugung von Dateiausgaben 
unterstützt.
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Position  und Grösse  der  Karte  sowie die  Position  eines  Titels,  einer  Legende, 
eines  Maßstabsbalkens  und  eines  Nordpfeils  sowie  eines  zusätzlichen  Textes 
kann über eine Druckformatvorlage vom Administrator festgelegt werden (s.u.). 
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Abbildung 2: Ablaufschema der Verarbeitung eines Druckauftrags
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3 Anfragen

Der  Druckservice  kennt  vier  Anfragemethoden:  GetCapabilities, 
GetAvailableTemplates,   DescribeTemplate  und  PrintMap.  Die  erste  Anfrage 
entspricht hinsichtlich ihrer Funktion der anderer OGC Web Services (OWS). Als 
Ergebnis erhält der Client ein XML-Dokument, das im wesentlichen einem WMS 
1.1.1 Capabilities-Dokument entspricht  und Auskunft  über die Fähigkeiten des 
WMPS gibt. Mit der GetAvailableTemplates- und  DescribeTemplate-Anfrage kann 
eine  Liste  der  verfügbaren  Templates  sowie  verfügbare  Elemente  eines 
Templates erfragt werden. Die PrintMap Anfrage dient der Beauftragung eines 
Ausdrucks; da es sich bei PrintMap um eine asynchrone Operation handelt, erhält 
der Nutzer zunächst nur eine Bestätigung über den Eingang seiner Anfrage. Nach 
Abschluss des Druckauftrags bzw. dei dessen Scheitern wird er via E-Mail über 
den Status informiert.

3.1 GetCapabilities-Anfrage

Die GetCapabilities-Anfrage ist nur für HTTP-Get definiert.

Anfrage Parameter Required/Op
tional

Beschreibung

REQUEST R Anfragename

VERSION=version O Version des Dienstes (default 1.0.0)

SERVICE=WMPS R Name des Dienstes

Beispiel:

http://localhost:8080/deegree-wmps/services?request=GetCapabilities& 
version=1.0.0&service=WMPS

3.2 GetCapabilities-Antwort

Die Antwort auf eine GetCapabilities-Anfrage entspricht der Antwort eines OGC 
WMS 1.1.1; lediglich die Request-Sektion ist dahingehend geändert, dass anstelle 
der WMS-spezifischen Anfragen ausschließlich GetCapabilities und PrintMap auf-
geführt sind.

Beispiel:

<?xml version="1.0" encoding="UTF-8"?>
<WMPS_Capabilities xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

version="1.1.1" updateSequence="1.1.0">
    <Service>
        <Name>WMPS</Name>
        <Title>deegree wmps</Title>
        <Abstract>wms reference implementation</Abstract>
        <KeywordList>
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            <Keyword>deegree</Keyword>
            <Keyword>wmps</Keyword>
        </KeywordList>
        <OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" xlink:href="http://www.deegree.org"/>
        <ContactInformation>
            <ContactPersonPrimary>
                <ContactPerson>Andreas Poth</ContactPerson>
                <ContactOrganization>lat/lon</ContactOrganization>
            </ContactPersonPrimary>
            <ContactPosition>Senior Consultant</ContactPosition>
            <ContactAddress>
                <AddressType>Postal</AddressType>
                <Address>Aennchenstr. 19</Address>
                <City>Bonn</City>
                <StateOrProvince>NRW</StateOrProvince>
                <PostCode>53177</PostCode>
                <Country>Germany</Country>
            </ContactAddress>
            <ContactVoiceTelephone>0049228184960</ContactVoiceTelephone>
            <ContactFacsimileTelephone>00492281849629</ContactFacsimileTelephone>
            <ContactElectronicMailAddress>info@lat-lon.de

 </ContactElectronicMailAddress>
        </ContactInformation>
        <Fees>none</Fees>
        <AccessConstraints>none</AccessConstraints>
    </Service>
    <Capability>
        <Request>
            <GetCapabilities>
                <Format>application/vnd.ogc.wms_xml</Format>
                <DCPType>
                    <HTTP>
                        <Get>
                            <OnlineResource

 xmlns:xlink="http://www.w3.org/1999/xlink" 
 xlink:type="simple" 
 xlink:href="http://127.0.0.1:8081/deegree-wmps/ser-

vices?"/>
                        </Get>
                    </HTTP>
                </DCPType>
            </GetCapabilities>
            <PrintMap>

  <Format>default</Format>
  <Format>LegendOnBottom</Format>
  <Format>LegendRight</Format>
  <Format>MyTemplate</Format>

                <DCPType>
                    <HTTP>
                        <Get>
                            <OnlineResource 

xmlns:xlink="http://www.w3.org/1999/xlink" 
xlink:type="simple" 
xlink:href="http://127.0.0.1:8081/deegree-

wmps/services?"/>
                        </Get>
                    </HTTP>
                </DCPType>
            </PrintMap>
        </Request>
        <Exception>
            <Format>application/vnd.ogc.se_xml</Format>
            <Format>application/vnd.ogc.se_inimage</Format>
            <Format>application/vnd.ogc.se_blank</Format>
        </Exception>
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        <!-- optional; default = all false -->
        <UserDefinedSymbolization SupportSLD="1" UserLayer="1" UserStyle="1"

 RemoteWFS="0"/>
        <Layer queryable="0" cascaded="0" noSubsets="0">
            <Title>Metropolregion WMPS</Title>
            <Abstract>WMPS of the Geoportal of the Metropolregion

 Hamburg</Abstract>
            <KeywordList>
                <Keyword>deegree</Keyword>
                <Keyword>layer</Keyword>
            </KeywordList>
            <SRS>EPSG:4326</SRS>
            <LatLonBoundingBox minx="-180" miny="-90" maxx="180" maxy="90"/>
            <ScaleHint min="0" max="100000000"/>
            <Layer queryable="0" cascaded="0" noSubsets="0">
                <Title>MRH layers</Title>
                <SRS>EPSG:31467</SRS>
                <LatLonBoundingBox minx="6" miny="51" maxx="13" maxy="56"/>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
                    <Name>mrh:kreise</Name>
                    <Title>Kreise der Metropolregion Hamburg</Title>
                    <Style>
                        <Name>default:mrh:kreise</Name>
                        <Title>default:mrh:kreise</Title>
                    </Style>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
                    <Name>mrh:gemeinden</Name>
                    <Title>Gemeinden der Metropolregion Hamburg</Title>
                    <Style>
                        <Name>default:mrh:gemeinden</Name>
                        <Title>default:mrh:gemeinden</Title>
                    </Style>
                </Layer>
            </Layer>
            <Layer queryable="0" cascaded="0" noSubsets="0">
                <Title>Hamburg layers</Title>
                <SRS>EPSG:31467</SRS>
                <LatLonBoundingBox minx="6" miny="51" maxx="13" maxy="56"/>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <SRS>EPSG:31467</SRS>
                    <Name>hamburg:bezirke</Name>
                    <Title>Bezirke von Hamburg</Title>
                    <Style>
                        <Name>default:hamburg:bezirke</Name>
                        <Title>default:hamburg:bezirke</Title>
                    </Style>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:FFH-Flaechen</Name>
                    <Title>hamburg:FFH-Flaechen</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:gewaesserguete99_flaechen</Name>
                    <Title>hamburg:gewaessergute99_flaechen</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:wasserschutzgebiete</Name>
                    <Title>hamburg:wasserschutzgebiete</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:landschaftsschutzgebiete</Name>
                    <Title>hamburg:landschaftsschutzgebiete</Title>
                </Layer>
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                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:oberflaechengewaesser</Name>
                    <Title>hamburg:oberflaechengewaesser</Title>
                </Layer>
                <Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
                    <Name>hamburg:gewaesserflaechen</Name>
                    <Title>hamburg:gewaesserflaechen</Title>
                </Layer>
            </Layer>
        </Layer>
    </Capability>
</WMPS_Capabilities>

3.3 GetAvailableTemplates

(deegree2 >=2.4) 

Die GetAvailableTemplates-Anfrage ist nur für HTTP-Get definiert. Diese Anfrage 
liefer eine Liste der 

Request Parameter Required/
Optional

Description

REQUEST=GetAvailableTemplates R Verfügbare Templates anzeigen

VERSION=version O Version des Dienstes (default 1.0.0)

SERVICE=WMPS R Service Typ

Table 1: GetAvailableTemplates request parameters

Beispielrequest:

http://localhost:8080/deegree-wmps/services?SERVICE=WMPS&REQUEST=GetAvaila-
bleTemplates&version=1.0.0

Beispielresponse:

<?xml version="1.0" encoding="UTF-8"?>
<deegreewmps:GetAvailableTemplatesResponse xmlns:deegreewmps="http://www.dee-
gree.org/wmps">
   <Template xmlns="http://www.deegree.org/wmps">template_2</Template>
   <Template xmlns="http://www.deegree.org/wmps">template_1</Template>
   <Template xmlns="http://www.deegree.org/wmps">default</Template>
</deegreewmps:GetAvailableTemplatesResponse>

3.4 DescribeTemplate

(deegree2 >=2.4)

Die DescribeTemplate-Anfrage ist nur für HTTP-Get definiert.

Request Parameter Required/Op
tional

Description

REQUEST=DescribeTemplate R Beschreibt angegebenes Template.
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Request Parameter Required/Op
tional

Description

VERSION=version O Version des Dienstes (default 1.0.0)

SERVICE=WMPS R Service Typ

TEMPLATE=templatename R Templatename  welches  beschrieben 
werden soll

Table 2: DescribeTemplate request parameters

Beispielrequest:

http://localhost:8080/deegree-wmps/services?
SERVICE=WMPS&REQUEST=DescribeTemplate&version=1.0.0&template=report1
Beispielresponse:

<?xml version="1.0" encoding="UTF-8"?>
<deegreewmps:DescribeTemplateResponse xmlns:deegreewmps="http://www.deegree.org/wmps">
   <Parameter xmlns="http://www.deegree.org/wmps" name="TITLE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="LOGO_URL" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="AUTHOR" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="DESCRIPTION" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="DATE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="SCALE" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="NOTES" type="java.lang.String"/>
   <Parameter xmlns="http://www.deegree.org/wmps" name="COPYRIGHT" type="java.lang.String"/>
</deegreewmps:DescribeTemplateResponse>

3.5 PrintMap-Anfrage

Über die PrintMap-Anfrage initialisiert ein Nutzer einen Druckauftrag. Dieser Um-
fasst neben der Information was gedruckt werden soll,  auch die Angabe eines 
Templates, das festlegt,  wie die zu druckenden Elemente angeordnet werden. 
Die Information über verfügbare Templates kann aus den Format-Elementen des 
PrintMap-Requests  im  WMPS-Capabilities  Dokument  ausgelesen  werden.  Die 
Menge der verfügbaren Templates wird vom Adminsitrator des Dienstes festge-
legt;  immer  verfügbar  ist  das  Template  mit  dem Namen  'default'.  Die  Print-
Map-Anfrage ist sowohl als Key-Value-Pair Encoding für HTTP-Get als auch als XM-
L-kodierte Anfrage für HTTP-Post definiert. 

3.5.1KVP - HTTP Get

Anfrage Parameter Required/Op
tional

Beschreibung

REQUEST=PrintMap R Anfragename

VERSION=Version O Version des Dienstes (default 1.0.0)

LAYERS=Layer Liste R Durch  Kommata  getrennte  Liste  der 
angefragten Layer

STYLES=Style Liste R Durch  Kommata  getrennte  Liste  der 
angefragten Styles
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Anfrage Parameter Required/Op
tional

Beschreibung

SRS=namespace:identifier R Räumliches Referenzsystem

BBOX=minx,miny,maxx,maxy C BoundingBox der Karte; wird benötigt 
wenn CENTER und SCALE nicht ange-
geben sind.

CENTER=x,y C Mittelpunkt  der  Karte;  muss  angege-
ben werden, wenn BBOX nicht defin-
eirt ist.

SCALE=n C Maßstab der  Karte;  muss  angegeben 
werden, wenn BBOX nicht definiert ist.

TRANSPARENT=TRUE/FALSE O Transparenz des Hintergrunds (default 
= FALSE)

BGCOLOR=color O Hexadezimale  Definition  der  Hinter-
grundfarbe (default = 0xFFFFFF)

TITLE=Titeltext O Titel der Karte 

COPYRIGHT=Copyrighttext O Copyright-Vermerk

LEGEND=TRUE/FALSE O Gibt  an,  ob  eine  Legende  gedruckt 
werden soll (default =  false)

SCALEBAR=TRUE/FALSE O Gibt  an,  on  die  Maßstabsdetails  ge-
druckt werden soll (default = false)

NOTE=Text O Ein zusätzlich zu druckender Text 

TEMPLATE=name O Zu verwendendes Template zur Anor-
dung  der  Kartenelement  (default  = 
default ) 

DPI=n O Druckauflösung  (default  wird  in 
wmps_configuration.xml definiert) (de-
egree2 >=2.4) 

EMAILADDRESS=mail_adresse R Adresse an die die Nachricht über den 
Abschluss  oder  das  Scheitern  des 
Druckauftrags geschickt werden soll

3.5.2XML-Kodierung HTTP-POST

Das Anfrageformat wird durch folgendes Schema beschrieben:

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http://www.deegree.org/wmps" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" 
xmlns:gml="http://www.opengis.net/gml" elementFormDefault="qualified">

<xs:import namespace="http://www.opengis.net/gml" 
schemaLocation="geometryBasic0d1d.xsd"/>

<xs:import namespace="http://www.opengis.net/sld" 
schemaLocation="StyledLayerDescriptor.xsd"/>

<xs:element name="PrintMap">
<xs:complexType>

<xs:sequence>
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<xs:element name="Layers" type="deegree:LayersType"/>
<xs:choice>

<xs:element ref="gml:Envelope"/>
<xs:sequence>

<xs:element name="Center" type="deegree:CenterType"/>
<xs:element name="ScaleDenomiator" type="xs:positiveInteger"/>

</xs:sequence>
</xs:choice>
<xs:element name="Transparent" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="BGColor" type="xs:string" minOccurs="0" 

default="0xFFFFFF"/>
<xs:element name="Legend" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="ScaleBar" type="xs:boolean" minOccurs="0" 

default="false"/>
<xs:element name="Template" type="xs:string" minOccurs=“0“ 

  default=“default“/>  
<xs:element name="EMailAddress" type="xs:string"/>
<xs:element name="TextAreas" type="deegree:TextAreasType" 

minOccurs="0"/>
</xs:sequence>
<xs:attribute name="version" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:complexType name="LayersType">

<xs:sequence>
<xs:choice>

<xs:element ref="sld:NamedLayer" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="sld:UserLayer" minOccurs="1" maxOccurs="unbounded"/>

</xs:choice>
</xs:sequence>

</xs:complexType>
<xs:complexType name="TextAreaType">

<xs:sequence>
<xs:element name="Name" type="xs:string"/>
<xs:element name="Text" type="xs:string"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="TextAreasType">

<xs:sequence>
<xs:element name="TextArea" type="deegree:TextAreaType" minOccurs="1" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CenterType">

<xs:sequence>
<xs:element ref="gml:pos"/>

</xs:sequence>
</xs:complexType>

</xs:schema>
In der vorliegenden Version des Dienstes werden für die Angabe der zu drucken-
den Layer ausschließlich sld:NamedLayer unterstützt.

Beispiel:

<?xml version="1.0" encoding="UTF-8"?>
<deegree:PrintMap xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" xmlns:gml="http://www.opengis.net/gml" 
version="1.0.0">

<deegree:Layers>
<sld:NamedLayer>

<sld:Name>europe:physical</sld:Name>
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<sld:NamedStyle>
<sld:Name>default</sld:Name>

</sld:NamedStyle>
</sld:NamedLayer>
<sld:NamedLayer>

<sld:Name>europe:major_rivers</sld:Name>
<sld:NamedStyle>

<sld:Name>default</sld:Name>
</sld:NamedStyle>

</sld:NamedLayer>
</deegree:Layers>

   <!-- either bbox using gml envelope -->
<gml:Envelope srsName="EPSG:4326">

<gml:pos>3 42</gml:pos>
<gml:pos>12 55</gml:pos>

</gml:Envelope>
   <!-- or deegree specific 'Center' with gml pos -->
   <!--
   <deegree:Center srsName="EPSG:4326">
      <gml:pos>3 42</gml:pos>
   </deegree:Center>
   <deegree:ScaleDenominator>100000</deegree:ScaleDenominator>
   -->

<deegree:Transparent>false</deegree:Transparent>
<deegree:BGColor>0xFF34F2</deegree:BGColor>
<deegree:Legend>true</deegree:Legend>
<deegree:ScaleBar>true</deegree:ScaleBar>
<deegree:Template>MyPrintTemplate</deegree:Template>
<deegree:EMailAddress>poth@lat-lon.de</deegree:EMailAddress>
<deegree:TextAreas>

<deegree:TextArea>
<deegree:Name>Title</deegree:Name>
<deegree:Text>Meine Karte</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>Copyright</deegree:Name>
<deegree:Text>(c) deegree 2006</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>MeineBeschreibung1</deegree:Name>
<deegree:Text>Dies ist meine erste gedruckte Karte</deegree:Text>

</deegree:TextArea>
<deegree:TextArea>

<deegree:Name>MeineBeschreibung2</deegree:Name>
<deegree:Text>Dies ist ein weiterer Beispieltext</deegree:Text>

</deegree:TextArea>
</deegree:TextAreas>

</deegree:PrintMap>

3.6 PrintMap-Anwort

Da eine PrintMap-Anfrage eine asynchrone Operation auslöst,  gliedert sich die 
Anwort in zwei unabhängige Teile. Direkt nach Abschicken der Anfrage durch den 
Nutzer erhält er vom WMPS eine Antwort, die Ihn über die erfolgreiche Annahme 
oder einen aufgetretenen Fehler beim Parsen der Anfrage informiert. Fehler kön-
nen z.B. durch unvollständige Anfragen oder Anfragen nach nicht vorhandenen 
Ressourcen entstehen (siehe auch Kap. Exceptions). Die Bestätigung der erfolg-
reichen Annahme erfolgt durch ein XML-Dokument dessen Schema im folgenden 
wiedergegeben ist.
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<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http:www.deegree.org/wmps"
 xmlns:wmps="http:www.deegree.org/wmps" xmlns:xs="http://www.w3.org/2001/XMLSchema"
 elementFormDefault="qualified" attributeFormDefault="unqualified">
    <xs:element name="PrintMapResponse" type="wmps:PrintMapResponseType"/>
    <xs:complexType name="PrintMapResponseType">
        <xs:sequence>
            <xs:element name="timestamp" type="xs:time"/>
            <xs:element name="message" type="xs:string" minOccurs="0"/>
            <xs:element name="expectedProcessingTime" type="xs:duration"
 minOccurs="0"/>
        </xs:sequence>
    </xs:complexType>
</xs:schema>
Beispiel:

<?xml version="1.0" encoding="UTF-8"?>
<PrintMapResponse xmlns="http:www.deegree.org/wmps">
    <timestamp>14:20:00-05:00</timestamp>
    <message>Ihr Druckauftrag wurde erfolgreich entgegen genommen. Sie werden per

 Email benachrichtigt, sobald der Auftrag abgearbeitet ist</message>
    <expectedProcessingTime>PT2H30M</expectedProcessingTime>
</PrintMapResponse>
Das Element <timestamp> gibt die Uhrzeit an, zu der der Druckauftrag beim 
WMPS eingegangen ist. Über das optionale Element <message> kann der Nutzer 
im Klartext über den erfolgreichen Eingang des Auftrags informiert werden. Das 
ebenfalls optionale Element <expectedProcessingTime> gibt die erwartete Bear-
beitungszeit für den Druckauftrag an; im Beispiel sind dies zwei Stunden und 30 
Minuten (zur Zeit nicht implementiert).

Nach Rückgabe der Empfangsbestätigung wird die Verbindung zwischen Client 
und Server beendet. Tritt während der Bearbeitung des Druckauftrags ein Pro-
blem auf, z.B. weil der Drucker die Entgegennahme weiterer Aufträge verweigert 
oder eine der einzubindenden Datenquellen nicht erreichbar ist, kann der Nutzer 
wie auch bei erfolgreichem Abschluss eines Druckauftrags nicht unmittelbar in-
formiert werden. Statt dessen wird an die in der Anfrage enthaltene E-Mail-Adres-
se eine Nachricht geschickt, die den Nutzer über den Status des Druckauftrags 
informiert und ihn z.B. auffordert, die ausgedruckte Karte beim zuständigen Ad-
ministrator abzuholen.

3.7 Antwort im Fehlerfall

Treten  bei  der  Entgegennahme  von  Anfragen  oder  der  Bearbeitung  von 
GetCapabilities-Requests  Probleme  auf,  wird  der  Nutzer  unmittelbar  durch 
Senden einer Exception darüber informiert. Das Format der Antwort entspricht 
dem, wie es für OGC Web Services in OWS Commons 1.1.0 spezifiziert ist.

(siehe Anhang 1)
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4 Konfiguration

Die Konfiguration des Druckservice entspricht im wesentlichen der eines deegree 
WMS, daher wird an dieser Stelle lediglich auf die deegree WMS Dokumentation 
verwiesen. Als eines der zusätzlichen Konfigurationselement wird die Definition 
der  <deegreewmps:CacheDatabase> benötigt. Dieses Element wird definiert die 
für den Aufbau der Verbindung zu einer Datenbank, in der die Zwischenspeiche-
rung der Anfragen erfolgt, benötigten Parameter. Das Element ist innerhalb des 
<deegreewmps:DeegreeParam> Elements zu definieren. 

<deegreewmps:DeegreeParam>
...
<deegreewmps:CacheDatabase>

<deegreewmps:JDBCConnection xmlns="http://www.deegree.org/jdbc">
<deegreewmps:Driver>driver</deegreewmps:Driver>
<deegreewmps:Url>database.url</deegreewmps:Url>
<deegreewmps:User>username</deegreewmps:User>
<deegreewmps:Password>password</deegreewmps:Password>

</deegreewmps:JDBCConnection>
</deegreewmps:CacheDatabase>
...
</deegreewmps:DeegreeParam>
Zusätzlich, es ist notwendig <deegreewmps:PrintMapParam> innerhalb von <de-
egreewmps:DeegreeParam> zu definieren. 

<deegreewmps:DeegreeParam>
...
<deegreewmps:PrintMapParam>

<!-- default: 300 (dpi) -->
<deegreewmps:TargetResolution>300</deegreewmps:TargetResolution>
<!-- default format 'pdf'. Supported formats 'pdf','rtf','html' -->
<deegreewmps:Format>pdf</deegreewmps:Format>
<deegreewmps:Template>
<deegreewmps:Directory>../../Template</deegreewmps:Directory>

</deegreewmps:Template>
<deegreewmps:PlotDirectory>download</deegreewmps:PlotDirectory>
<deegreewmps:OnlineResource>
http://MyServer:8081/portal

</deegreewmps:OnlineResource>
<deegreewmps:PlotImageDirectory>
WEB-INF/temp/image
</deegreewmps:PlotImageDirectory>
<deegreewmps:MailHost>mail.lat-lon.de</deegreewmps:MailHost>
<deegreewmps:MailHostUser>loginname</deegreewmps:MailHostUser>
<deegreewmps:MailHostPassword>password</deegreewmps:MailHostPassword>
<deegreewmps:AdministratorEMailAddress>poth@lat-lon.de

</deegreewmps:AdministratorEMailAddress>
<deegreewmps:MailTextTemplate>
The PrintMap request recieved has been successfully printed out in the 
format requested. You can access the result at {0}/{1}

</deegreewmps:MailTextTemplate>
</deegreewmps:PrintMapParam>

...
</deegreewmps:DeegreeParam>

Im Element <deegreewmps:PrintMapParam> wird das Format der Ergebnisse von 
PrintMap Anfragen  festgelegt . Per default wird das Ergebnis als 'pdf-Datei' ex-
portiert; alternativ können auch die Formate 'html' und 'rtf' benutzt werden. Die 
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Drucktemplates (s.u.) müssen dem WMPS in einem definierten Verzeichnis bereit 
gestellt werden. Das Verzeichnis muss im Konfigurationsdokument unter <dee-
greewmps:Template> festgelgt werden. 

Die Verzeichnis für die Zwischenspeicherung von Teilerergebnissen wird über das 
Element  <deegreewmps:PlotImageDirectory>  definiert.  Es  dient  lediglich  der 
temporären Ablage von Zwischenergebnissen und sollte daher  in  einem nicht 
nach Aussen sichtbaren Teil der Anwendung liegen. Über das Element <deegree-
wmps:PlotDirectory> wird das Verzeichnis definiert in dem die finalen Druckan-
sichten abgelegt werden. Je nach Zugriffsart (direkt oder indirekt über eine ge-
sonderete Webanwendung) sollte dieses im sichtbaren oder nicht sichtbaren Be-
reich der Anwendung liegen. <deegreewmps:OnlineResource> ist optional. Hierr-
über wird angeben, über welche Adresse die Ergebnissdateien verfügbar sein sol-
len. 

Wie oben angegeben wird der Nutzer per EMail benachrichtigt sobald sein Auf-
trag erfolgreich ausgeführt worden ist und ihm ein Link zur Verfügung gestellt, 
der dien Download des Ergebnisses ermöglicht. Der Administrator muss über das 
Element <deegreewmps:MailHost> ein Email Host definieren, worüber die Ant-
wortmails  verschickt  werden können.  Ggf.  sind  <deegreewmps:MailHostUser> 
und <deegreewmps:MailHostPassword> zu  ergänzen.  Das  Element  <deegree-
wmps:AdministratorEMailAddress> gibt die Mailadresse des Absender der Ant-
wortmail an. Ein vollständiges WMPS Capabilities Dokument ist in Anhang 2 zu 
finden.

Die Konfiguration der Drucktemplates muss zusätzlich zur Konfiguration der Ca-
pabilities  erfolgen.  Intern verwendet  der  deegree Druckdienst  das Open-Sour-
ce-Projekt Jasper-Reports. Dieses verwendet Templates mit denen Grafiken und 
Textelemente frei auf einer Druckvorlage positioniert werden können. Zur Erstel-
lung und Bearbeitung der Templates kann das Open-Source-Projekt iReport ver-
wendet werden (Abbildung 3). Ein Template kann neben einem Kartenbild, einer 
Legende und einem Nordpfeil als vordefinierte graphische Elemente beliebig vie-
le statische und dynamische Textbereiche sowie statische graphische Elemente 
beinhalten. Bei dynamischen Elementen handelt es sich um solche Elemente, die 
zur Laufzeit aus den Angaben in der PrintMap-Anfrage gefüllte werden; der Inhalt 
statischer Element wird dagegen bereits zur Designzeit festgelegt (z.B. ein Logo).
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5 Anhang 1

Schemadefinition für Fehlerenachrichtigungen (aus OWS Commons 1.1.0):

<?xml version="1.0" encoding="UTF-8"?>
<schema targetNamespace="http://www.opengis.net/ows"
 xmlns:ows="http://www.opengis.net/ows" xmlns="http://www.w3.org/2001/XMLSchema"
 elementFormDefault="qualified" version="1.1.0" xml:lang="en">
    <annotation>
        <appinfo>owsExceptionReport.xsd 2005-09-19</appinfo>
        <documentation>This XML Schema Document encodes the Exception Report 

response to all OWS operations. 
Copyright (c) Open Geospatial Consortium (2005) </documentation>

    </annotation>
    <!-- ==============================================================

elements and types
============================================================== -->

    <element name="ExceptionReport">
        <annotation>
            <documentation>Report message returned to the client that requested any

 OWS operation when the server detects an error while processing that
 operation request. </documentation>

        </annotation>
        <complexType>
            <sequence>
                <element ref="ows:Exception" maxOccurs="unbounded">
                    <annotation>
                        <documentation>Unordered list of one or more Exception

 elements that each describes an error. These Exception
elements shall be interpreted by clients as being independent

 of one another (not hierarchical). </documentation>
                    </annotation>
                </element>
            </sequence>
            <attribute name="version" use="required">
                <annotation>
                    <documentation>Specification version for OWS operation. The 
string value shall contain one x.y.z "version" value (e.g., "2.1.3"). A version 
number shall contain three non-negative integers separated by decimal points, in 
the form "x.y.z". The integers y and z shall not exceed 99. Each version shall be 
for the Implementation Specification (document) and the associated XML Schemas to 
which requested operations will conform. An Implementation Specification version 
normally specifies XML Schemas against which an XML encoded operation response must 
conform and should be validated. See Version negotiation subclause for more infor-
mation. </documentation>
                </annotation>
                <simpleType>
                    <restriction base="string">
                        <pattern value="\d+\.\d?\d\.\d?\d"/>
                    </restriction>
                </simpleType>
            </attribute>
            <attribute name="language" type="language" use="optional">
                <annotation>
                    <documentation>Identifier of the language used by all included 
exception text values. These language identifiers shall be as specified in IETF RFC 
1766. When this attribute is omitted, the language used is not identified. </docu-
mentation>
                </annotation>
            </attribute>
        </complexType>
    </element>
    <!-- ======================================================= -->
    <element name="Exception" type="ows:ExceptionType"/>
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    <!-- ======================================================= -->
    <complexType name="ExceptionType">
        <annotation>
            <documentation>An Exception element describes one detected error that a

 server chooses to convey to the client. </documentation>
        </annotation>
        <sequence>
            <element name="ExceptionText" type="string" minOccurs="0"

 maxOccurs="unbounded">
                <annotation>
                    <documentation>Ordered sequence of text strings that describe 
this specific exception or error. The contents of these strings are left open to 
definition by each server implementation. A server is strongly encouraged to inclu-
de at least one ExceptionText value, to provide more information about the detected 
error than provided by the exceptionCode. When included, multiple ExceptionText va-
lues shall provide hierarchical information about one detected error, with the most 
significant information listed first. </documentation>
                </annotation>
            </element>
        </sequence>
        <attribute name="exceptionCode" type="string" use="required">
            <annotation>
                <documentation>A code representing the type of this exception,

 which shall be selected from a set of exceptionCode values
 specified for the specific service operation and server.
</documentation>

            </annotation>
        </attribute>
        <attribute name="locator" type="string" use="optional">
            <annotation>
                <documentation>When included, this locator shall indicate to the 
client where an exception was encountered in servicing the client's operation re-
quest. This locator should be included whenever meaningful information can be pro-
vided by the server. The contents of this locator will depend on the specific ex-
ceptionCode and OWS service, and shall be specified in the OWS Implementation Spe-
cification. </documentation>
            </annotation>
        </attribute>
    </complexType>
</schema>

Schemadefinition für PrintMap-Anfragen:

<?xml version="1.0" encoding="UTF-8"?>
<xs:schema targetNamespace="http://www.deegree.org/wmps" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:deegree="http://www.deegree.org/wmps" 
xmlns:sld="http://www.opengis.net/sld" 
xmlns:gml="http://www.opengis.net/gml" elementFormDefault="qualified">

<xs:import namespace="http://www.opengis.net/gml" 
schemaLocation="geometryBasic0d1d.xsd"/>

<xs:import namespace="http://www.opengis.net/sld" 
schemaLocation="StyledLayerDescriptor.xsd"/>

<xs:element name="PrintMap">
<xs:complexType>

<xs:sequence>
<xs:element name="Layers" type="deegree:LayersType"/>
<xs:choice>

<xs:element ref="gml:Envelope"/>
<xs:sequence>

<xs:element name="Center" type="deegree:CenterType"/>
<xs:element name="ScaleDenomiator" type="xs:positiveInteger"/>

</xs:sequence>
</xs:choice>
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<xs:element name="Transparent" type="xs:boolean" minOccurs="0" 
default="false"/>

<xs:element name="BGColor" type="xs:string" minOccurs="0" 
default="0xFFFFFF"/>

<xs:element name="Legend" type="xs:boolean" minOccurs="0" 
default="false"/>

<xs:element name="ScaleBar" type="xs:boolean" minOccurs="0" 
default="false"/>

<xs:element name="Template" type="xs:string" minOccurs="0" 
default="default"/>

<xs:element name="EMailAddress" type="xs:string"/>
<xs:element name="TextAreas" type="deegree:TextAreasType" 

minOccurs="0"/>
</xs:sequence>
<xs:attribute name="version" type="xs:string" use="required"/>

</xs:complexType>
</xs:element>
<xs:complexType name="LayersType">

<xs:sequence>
<xs:choice>

<xs:element ref="sld:NamedLayer" minOccurs="1" maxOccurs="unbounded"/>
<xs:element ref="sld:UserLayer" minOccurs="1" maxOccurs="unbounded"/>

</xs:choice>
</xs:sequence>

</xs:complexType>
<xs:complexType name="TextAreaType">

<xs:sequence>
<xs:element name="Name" type="xs:string"/>
<xs:element name="Text" type="xs:string"/>

</xs:sequence>
</xs:complexType>
<xs:complexType name="TextAreasType">

<xs:sequence>
<xs:element name="TextArea" type="deegree:TextAreaType" minOccurs="1" 

maxOccurs="unbounded"/>
</xs:sequence>

</xs:complexType>
<xs:complexType name="CenterType">

<xs:sequence>
<xs:element ref="gml:pos"/>

</xs:sequence>
</xs:complexType>

</xs:schema>
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6 Anhang 2

WMPS Capabilities:

<?xml version="1.0" encoding="UTF-8"?>
<WMT_PS_Capabilities xmlns:deegree="http://www.deegree.org/wmps" 

        xmlns:deegreewmps="http://www.deegree.org/wmps" 
                  xmlns:gml="http://www.opengis.net/gml" version="1.1.1" 

 updateSequence="1.1.0">
<deegreewmps:DeegreeParam>
<deegreewmps:DefaultOnlineResource xmlns:xlink="http://www.w3.org/1999/xlink"

xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-

wmps/services"/>
<!-- default = 100 (MB) -->
<deegreewmps:CacheSize>100</deegreewmps:CacheSize>
<!-- maximum lifetime of the processes in the wmps; default = 3600 (sec)-->
<deegreewmps:MaxLifeTime>3600</deegreewmps:MaxLifeTime>
<!-- maximum time for the execution of a request until an exception of time-ex

  ceed is thrown default 15 Sekunden -->
<deegreewmps:RequestTimeLimit>35</deegreewmps:RequestTimeLimit>
<!-- determines the quality of the map/image generated from a PrintMap request.

    the parameter only will be evaluated if the desired format is able to handle 
it. the range of values is 0 ... 1, where 1 is best and 0 is worst. default is 0.95 
  -->
<deegreewmps:MapQuality>1.00</deegreewmps:MapQuality>
<!-- maximum map width that can be requested. default = 1000 -->
<deegreewmps:MaxMapWidth>5000</deegreewmps:MaxMapWidth>
<!-- maximum map height that can be requested. default = 1000 -->
<deegreewmps:MaxMapHeight>5000</deegreewmps:MaxMapHeight>
<!-- copyright note that will be  drawed at the letf side of the maps bottom -->
<Copyright>(c) deegreewmps 2009</Copyright>
<!-- returns the URl where the DTD for OGC wmps capabilities DOCTYPE definiton
  is located. default = 

http://schemas.opengis.net/wmps/1.1.1/wmps_MS_Capabilities.dtd -->
<deegreewmps:DTDLocation>
<deegreewmps:OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" 

xlink:href="http://schemas.opengis.net/wmps/1.1.1/WMS_MS_Capabilities.dtd">
</deegreewmps:OnlineResource>

</deegreewmps:DTDLocation>
<!-- define a proxy server if the wmps is seperated by a firewall from the DTD-

location or the
       locations of connected REMOTEWFS, REMOTEWCS and REMOTEWMS 
       as an alternative you can set commandline parameters at the call of the 

java
       interpreter like this: java -DproxyHost=131.220.106.104 -DproxyPort=1234 

-classpath ...
-->
<!--Proxy proxyHost="131.220.106.104" proxyPort="1234"/-->
<deegreewmps:CacheDatabase>
<deegreewmps:JDBCConnection xmlns="http://www.deegree.org/jdbc">
<deegreewmps:Driver>org.hsqldb.jdbcDriver</deegreewmps:Driver>
<deegreewmps:Url>jdbc:hsqldb:file:/D:/Deploy/wmps_dmz1/database/wmpsPrintMap

    </deegreewmps:Url>
<deegreewmps:User>sa</deegreewmps:User>
<deegreewmps:Password></deegreewmps:Password>

</deegreewmps:JDBCConnection>
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</deegreewmps:CacheDatabase>
<deegreewmps:PrintMapParam>
<deegreewmps:Format>pdf</deegreewmps:Format>
<deegreewmps:Template>
<deegreewmps:Directory>../../Template</deegreewmps:Directory>

</deegreewmps:Template>
<deegreewmps:PlotDirectory>D:\Java\Projekte\wuppertal-

portal\webapps\portal_dmz1\download
</deegreewmps:PlotDirectory>

<deegreewmps:OnlineResource>http://10.19.1.222:8081/portal</deegreewmps:OnlineResou
rce>

<deegreewmps:PlotImageDirectory>../download/image</deegreewmps:PlotImageDirectory>
<deegreewmps:MailHost>mail.lat-lon.de</deegreewmps:MailHost>
<deegreewmps:MailHostUser>loginname</deegreewmps:MailHostUser>
<deegreewmps:MailHostPassword>password</deegreewmps:MailHostPassword>

<deegreewmps:AdministratorEMailAddress>poth@lat-lon.de
</deegreewmps:AdministratorEMailAddress>

</deegreewmps:PrintMapParam>
</deegreewmps:DeegreeParam>
<Service>
<Name>deegreewmps wmps</Name>
<Title>deegreewmps wmps</Title>
<!-- abstract und keywords are optional -->
<Abstract>wmps reference implementation</Abstract>
<KeywordList>
<Keyword>deegreewmps</Keyword>
<Keyword>WMPS</Keyword>

</KeywordList>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 

xlink:href="http://127.0.0.1:8080/deegree-wmps/services">
</OnlineResource>
<ContactInformation>
<ContactPersonPrimary>
<ContactPerson>Andreas Poth</ContactPerson>
<ContactOrganization>lat/lon</ContactOrganization>

</ContactPersonPrimary>
<ContactPosition>Developer</ContactPosition>
<ContactAddress>
<AddressType>Office</AddressType>
<Address>Aennchenstr. 19</Address>
<City>Bonn</City>
<StateOrProvince>NRW</StateOrProvince>
<PostCode>53177</PostCode>
<Country>Germany</Country>

</ContactAddress>
<ContactVoiceTelephone>0049-228-18496-0</ContactVoiceTelephone>
<ContactFacsimileTelephone>0049-228-18496-29</ContactFacsimileTelephone>
<ContactElectronicMailAddress>poth@lat-lon.de</ContactElectronicMailAddress>

</ContactInformation>
<Fees>none</Fees>
<AccessConstraints>none</AccessConstraints>

</Service>
<Capability>
<Request>
<!-- by default available -->
<GetCapabilities>
<!-- default and mandatory = application/vnd.ogc.wmps_xml -->
<Format>application/vnd.ogc.wmps_xml</Format>
<DCPType>

<HTTP>
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<Get>
<OnlineResource 

xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wmps/services?"/>

</Get>
<!-- POST isn't supported -->

</HTTP>
</DCPType>

</GetCapabilities>
<!-- by default available -->
<PrintMap>
<!-- default = image/gif; image/png; image/jpg -->
<!-- mandatory = image/png -->
<Format>image/gif</Format>
<Format>image/png</Format>
<Format>image/jpg</Format>
<Format>image/tif</Format>
<Format>image/bmp</Format>
<DCPType>

<HTTP>
<Get>

<OnlineResource 
xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wmps/services?"/>

</Get>
<Post>

<OnlineResource 
xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wmps/serices"/>

</Post>
</HTTP>

</DCPType>
</PrintMap>

</Request>
<Exception>
<!-- default & mandatory= application/vnd.ogc.se_xml -->
<Format>application/vnd.ogc.se_xml</Format>
<Format>application/vnd.ogc.se_inimage</Format>
<Format>application/vnd.ogc.se_blank</Format>

</Exception>
<!-- optional; default = all false -->
<UserDefinedSymbolization SupportSLD="1" UserLayer="1" UserStyle="1" 

RemoteWFS="0"/>
<!-- cascaded is optional and default=false -->
<!-- TOP LAYER -->
<Layer queryable="0" cascaded="0" noSubsets="0">
<Name>TopLevel</Name>
<Title>deegree demo-CD top-level-layer</Title>
<!-- abstract and keyword are optonal -->
<Abstract>the top-level-layer of the deegree demo-CD</Abstract>
<KeywordList>
<Keyword>deegree</Keyword>
<Keyword>demo-CD</Keyword>
<Keyword>layer</Keyword>

</KeywordList>
<SRS>EPSG:4326</SRS>
<SRS>EPSG:31466</SRS>
<SRS>EPSG:31467</SRS>
<!--<LatLonBoundingBox minx="-10" miny="-10" maxx="10" maxy="10"/>-->
<LatLonBoundingBox minx="-180" miny="-90" maxx="180" maxy="90"/>
<!-- default 0 ; 9E99  -->
<ScaleHint min="0" max="999999999"/>
<!-- Bonner daten -->

Web Map Print Service (WMPS) 2007-11-09 23



raumbezogene
informationssysteme

<Layer queryable="1" noSubsets="0" fixedWidth="0" fixedHeight="0">
<Name>gemischte_bauflaeche</Name>
<Title>Bonn</Title>
<SRS>EPSG:31466</SRS>
<deegree:DataSource failOnException="1" queryable="1" 

xmlns:app="http://www.deegree.org/app">
<deegree:Type>LOCALWFS</deegree:Type>
<deegree:Name>app:gemischte_bauflaeche</deegree:Name>
<deegree:GeometryProperty>app:GEOM</deegree:GeometryProperty>

</deegree:DataSource>
<Style>

<Name>default:gemischte_bauflaeche</Name>
<Title>Legend</Title>
<!--LegendURL width="72" height="72">

<Format>image/gif</Format>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" xlink:href="http://www.exploremaps.com/Media/Legend%20for
%20web.jpg"/>

</LegendURL-->
</Style>

</Layer>
<!-- Demo CD layers -->
<Layer queryable="1" opaque="0" noSubsets="0" fixedWidth="0" fixedHeight="0">
<Name>europe:country</Name>
<Title>Country border</Title>
<SRS>EPSG:4326</SRS>
<deegree:DataSouce failOnException="1" queryable="1" 

xmlns:app="http://www.deegree.org/app">
<deegree:Type>REMOTEWMS</deegree:Type>
<deegree:OWSCapabilities>

<deegree:OnlineResource 
xmlns:xlink="http://www.w3.org/1999/xlink" xlink:type="simple" 
xlink:href="http://127.0.0.1:8080/deegree-wms/services?
service=WMS&amp;version=1.1.1&amp;request=GetCapabilities"/>

</deegree:OWSCapabilities>
<deegree:FilterCondition>

<deegree:WMSRequest><!
[CDATA[Version=1.1.1&FORMAT=image/png&TRANSPARENT=false&EXCEPTIONS=application/vnd.
ogc.se_inimage&BGCOLOR=0xffffff&LAYERS=country&STYLES=]]></deegree:WMSRequest>

</deegree:FilterCondition>
</deegree:DataSouce>
<Style>

<Name>default:country</Name>
<Title>country border</Title>
<!--LegendURL width="72" height="72">

<Format>image/gif</Format>
<OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" xlink:href="http://www.exploremaps.com/Media/Legend%20for
%20web.jpg"/>

</LegendURL-->
</Style>

</Layer>
</Layer>

</Capability>
</WMT_PS_Capabilities>
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